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e Start Labview

O pe n a n eW p rOJ eCt * Note the Tutorial and Project tabs

— Excellent tutorials are included

 From the File menu, or by clicking
“New” on the Projects tab, open a
new project using the create new
“project from wizard”

_—r - |
{B LabVIEWV 22 . Select the “FRC cRIO Robot Project’

Projects wizard

 Rename it to something unique

- N ki * Enter team number instead of xx.yy
B for cRIO IP address

— e.g. 10.xx.yy.2 = 10.4.96.2

[l 2013 Robot Project Tank.lvproj

,Ttgg. 2012 Robot Project.vproj ° Select
I Browse...

— “Arcade Drive hardware only”
 Click Finish, and wait

— The project file will be in the
Documents/LabView Data folder.
You can copy the folder to
another computer if you wish.

File Operate Tools Help

Tutorials New
%, Blank VI
%) FRC cRIO Robot Project

Utilities




Build and Download the Project

File Edit View Project Operate Tools Window Help
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lterns | Files

=} |_£|, Project: 2013 Robot Project Test.lvproj
= E] I"-ﬂ}r Computer
{ ':q' Dependencies
-lr Build Specifications
=1 ﬂ RT CompactRIO Target (10.4.96.2)
= [J Team Code
- =l Beginwi
|_£|, Autonomous Independent.vi
gﬂ, Teleop.vi
gﬂ Testwvi
- [l Disabled.vi
- |mll Vision Processing.vi
=l Periodic Tasks.wvi
- |mll Robot Global Data.vi
- =l Finish.vi
+ [ Support Code

|_£|, Robot Main.vi
+ ' Dependencies
= --r_ Build Specifications

FRC Robot Boot-up Deployment

Open a project by clicking on its name
under Open on the Project tab

Every project has three pieces
— Begin.vi
— Teleop.vi
— Finish.vi

Later, we will edit these pieces

For now, right click on “FRC Robot
Boot-up Deployment”
— Select “puild”, and wait

Connect the computer to the Robot
using an ethernet cable (not wireless)

— Use 10.xx.yy.6 for the Driver
Station with a mask of 255.0.0.0

— Oruse 10.xx.yy.51 for a different
computer, where xx.yy are you
team numbers. e.g. 10.4.96.51

Right click on “FRC Robot Boot-up
Deployment”

— Select “Run as startup”, and wait



Three Easy Pleces

v & IEI|"'EI|'E' | 13pt Application Font ||« |‘?

Until the communications specify the mode,
initialize it to a safe value.

x
File Edit View Project Operate Tools Window Help .
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RightMotorlnverted
LefthMotorlnverted

Left Motor [0 PWM 1 Y— B T T

Right Motor (¢ PWM 2 ~ :MIZITIZIF‘ _}@ MI_ ConFIs
laguar =

|initia|ize two mu:utu:ur5|

IJ-:nistick 1 I

Jdoyreizk Joyrtizk
wUUSE T -

Open —}@

linitialize a joystick]

2013 Robot Project Test.lvproj/RT CompactRIO Target <

Begin.vi

All project have three easy
pieces

— Begin.vi
— Teleop.vi
— Finish.vi

Joysticks, Drive motors,
and Spike Relays (etc.)
are created and initialized
in Begin.vi

Action takes place in
Teleop.vi

Joysticks, Drive motors,
etc. are closed in Finish.vi

All three pieces are
essential

The Begin.vi for the arcade
drive project is shown here



' «  The Teleop.vi for th
Te I eO p . VI arceadg gﬁ\r/)evilnglrutdees
Joysticks and Motors

* There are other elements
_ in the Teleop.vi that are
File Edit View Project Operate Tools Window Help placed here by US FIrSt

[>[®]/©[1][@][25] [+a]@ - [15pt Application Font |+ | (3 |[ia= | [ | ? Y We will not touch them.

|ReadJuystick)(and"r‘valuesand updatemntorvalues| b But We can and ShOUId ed|t
the pieces shown at the left

ILeft and Ri htMu:utu:ursI IRDhutDrive Motors .
_—— —— s « Note that wires connect

- Freade ' different elements in the
Joystick 1 Publish the Robot Drive Motor dlagram

values to the dashboard

Joyrtizk

[ i « Communication between
different vi's (from Begin to
Teleop, for example) is

[loystick 1/Axes} g_@ achieved by burying the
—_ wires underground in
Dy Votons] 25 Begin.vi and then pulling
— them out of the ground in
robot sees to the dashboard Teleop.vi or Finish.vi using

symbols related to this one:

2013 Robot Project Test.lvproj/RT CompactRIO Target <

Juyrtick JovwstickDevRef

[#1-

refnum name

Te | eo p V| error in {no error)

error out

“Pulling a wire out of the ground”



The Finishing Piece

File Edit View Project Operate Tools Window Help
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Joystick 1

Joyrtizk|
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fLeft and Right Motors|

Dirive

[#~

Camera Camera

|E|—> CLOZE

Stop all parallel
[Close Refs, save data, etc. | loops, exit program

OO0 0000000000000 0000000000amn

2013 Robot Project Test.lvproj/RT CompactRIO Target <

Finish.vi

The Finish.vi for the
arcade drive robot is
shown at left

All elements opened
in Begin.vi must be
closed here

If you edit Begin.vi
and add elements,
then they must be
closed in Finish, too.

The block diagrams
(e.g. shown at left)
are made visible by
clicking on “Show
Block Diagram” on
the Window menu

You can get help on
any symbol by
enabling Context
Help on the Help
menu. Then hover
your mouse over the
symbol of interest.



Backup Slides
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Left Motor [wPWIM 1 ~
: Publish the Rebot Drive Motor

Dirive x Drive Dirive

Right Motor ¢+ PWM 2 = ZO;E:OP _,@ sareny st doertich] values to the dashboard

Publish the joystick axis
values to the dashboard

Joystick 1 Publish the joystick butten
wvalues to the dashboard

= Jertizh

[

Joystick 2

Jovystick 2

Joyrtick F Joyrtick

Dpen —)@
initialize joysticks : =)

2013 Robot Project Tank.lvproj/RT CompactRIO Target < 2013 Robot Project Tank.vproj/RT CompactRIO Target <

Begin.vi Teleop.vi

[oriveMotors] = O « Tank Drive example (with two motors)
showing essential elements from

Joyrrizk| Joyrrizk

J ick 1 . .

2 - Cloze — Begin.vi

Jovstick E' Jayrtizk Joyrkizk - Teleop.VI
B — Finish.vi

A four motor tank drive can also be done
Finish.vi — See the WPI Robotics Library menu




File Edit Wiew Project Operate Tools Window Help
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File Edit View Project Operate Tools Window He.
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{* Digital Module 1 v}—

{* Both directions |- Soike Motor 1

+Relay 1 =} Fielay 14

OFEM

Spike Motor 2

i** Relay 2 ".I Bielay |

OFEM
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Teleop.vi

2013 Robot Project Tank.lvproj/RT CompactRIO Target «

Begin.vi
* Relay example showing essential
elements to operate a Spike Relay
Spike Motor 1 FEM_} ET: _ Begin.vi
Spike Motor 2 Fielay Fielay _ T_el_eop-\_/l
El — Finish.vi

Finish.vi




Relays in more detail: One easy way to create a drop down menu box
for use with a relay “Set” function and a logical “Select” function is to
create a constant on the Relay value line before doing anything else.
This will create a drop down menu box. Stretch the wire to the drop
down menu by moving the menu to the left and then use the “insert”
option (touch the wire and right click) to insert a “Select” switch on the
wire between the Set function and the drop down menu box. The
“Select” switch is smart enough to change its default type from T/F to a
drop down menu once a menu box has been created on either the “t”
or “f” input so now you can easily create an additional menu box on the
other (t or f) input.

Select

RelayDevRef Relay RelayDevRef
t

] 2tf Relay¥alue - SET
5 ’ sE error in (no error) === error out
i

The “s” input to the “Select” switch should be a T/F input such as a joy
stick button or a digital I/O value (DIOIn) from a limit switch.




- Fielay Fielay
File Edit View Project Operate Tools Window He Spike Motor 2

[#~ SET
> [2] @[N][@] 28] [wa[w -2 1A [?

[Limit Switch 1}~ DD
[j-} GET

{* Digital Madule 1 *}—

Lirnit Switch 1

foDi0 1 e Simple Teleop Example w/ limit switch

Lirmit Switch 2

= L EEm ; ISEike Motor EI

Fielay Fielay
ZET

QFEH

ILimit Switch 'II ---------

2013 Robot Project Tank.vproj/RT CompactRIO Target «

Begin.vi
Teleop w/ limit switch and JS button
[t Swich 1} B8 OO, * DIO examples showing essential
elements to read a limit switch and
RLimt Switch 2p-E 0 - provide input to a Relay
Ooooooooooo - BeganI
Finish vi — two Teleop.vi examples
nish.v — Finish.vi




How to connect a
limit switch to the
Digital Sidecar

Use Black-Red-White
tricolor wire with black
connectors. Cut in the
middle, extend wires and
crimp on small sized
push-on connectors.

Note to experts: you can
reverse the logic of the switch
by changing the location of the
black wire on the switch
(reverse NC and NO wires).
Do not move the white wire.

Black Wire (Minus/Ground)
From digital sidecar

No connection
Red (Power) not connected

From digital sidecar



File Edit View Project Operate Tools Window Help
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lRobotDrive Motors . .
rive rw: —DE; i Tank.DrIVe Wlth tWO
Joysticks and
Publich the Robot Drive Motor feedbaCk to the
IJD <tick 11 i t- [ walues to the dashboard dashboard
| Publish the joystick axis
walues to the dashboard ° Slmple Teleop Tank
Publish the joystick button Dr'Ve example
sol| | |walues to the dashboard .
= showing a
[oystickc 2}-r== " = — Splke Motor
attached to Joystick 2
p « The motor starts on
o Button 1 click and

stops when Button 1
Is released. There is
Lspike Motor 1} no limit to the amount

of forward travel.

Button 1

2013 Robot Project Tank.lvproj/RT CompactRIO Target <




File Edit View Project Operate Tocls Window Help
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Drive e Publish the Robot Drive Motor

&= T @ values to the dashboard o Complex Teleop
[ = AE example showing
=l — Spike Motor

@ Publish the joystick axis _ Limit Switch DIO

values to the dashboard

o] Publish the joystick button attaChed to JoyStICk 2

values to the dashboard

IJ nistick 2'[

e Tank Drive with two
Joysticks and
feedback to the
dashboard

 The motor starts on
Button 2 click but
stops when the limit
switch is closed.

JLimit Switch 1}

Note to experts: The logic of the limit
switch (DIO in) depends on how the
limit switch is wired (normal or
reversed NC and NO wires)

2013 Robot Project Tank.vproj/RT CompactRIO Target <
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Jowstick 1 doyrtick Joyrtick

@—:v Cloze

Joystick 2 doyrtick Joyrtick
Cloze

Stop all parallel

[Close Refs, save data, etc.| e

Spike Motor 1}

Spike Motor 2|

Limit Switch 1}

Limit Switch 2}

Oooooooooooo0ooooooooooooooooooooonnann
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Finish.vi for the Tank Drive with 2 Joysticks, 2 Relays, and 2 Limit Switches (DIO)




Specifications for 2013



Team 496 2013 Robot Specifications as of Feb 15"

Tools:

Drive mechanism (2 CIM motors, tank drive)

Frisbee throwing arm (2 CIM motors, one globe motor, 1 limit switch)
Climbing apparatus (1 van door motor, 2 limit switches)

Ballast mechanism (battery) (1 globe motor, 2 limit switches)

Battery Ballast mechanism goes in and out and is protected with simple limit switches

Climbing mechanism goes up and down and is protected by limit switches. But the limit
switches latch off once they are touched. The latch is released when the “other” direction
switch is pushed. For example, push and hold the up button and the robot will climb until it
hits the upper limit switch. After it hits the limit, then additional pushes on the up button have
no effect. The robot can slowly drift downwards under its own weight. The latch is not
released until you push the down button whereupon the latch is released and the robot starts
to climb down.

Frisbee throwing mechanism. Joystick 3 must be pushed all the way forward to start the
throwing motors spinning. Push button 5 to throw a Frisbee. The injector mechanism will
come to rest against a stop. Push button 4 to advance past the stop. Push button 5 again
to throw another Frisbee.

(continued)



Team 496 2013 Robot: Breakdown by Electronic unit

— Joystick 1: Left Motor
— Joystick 2: Right Motor
— Joystick 3: (Two) Frisbee Throwing motors

— PWM 1: Left Drive motor

— PWM 2: Right Drive motor

— PWM 3: Frisbee throwing motor
— PWM 4: Frisbee throwing motor

— Button 6, Joystick 2: Climb Up

— Button 7, Joystick 2: Climb Down

— Button 10, Joystick 2: Battery out (back)
— Button 11, Joystick 2: Battery in (forward)

— Button 4, Joystick 3: Advance Frisbee rotor past stop
— Button 5, Joystick 3: Throw Frisbee (i.e. fire) and then rest rotor at stop

— Spike Relay 1. Climbing motor
— Spike Relay 2: Ballast motor (battery)
— Spike Relay 3: Frisbee Injector Motor

— Digital 10 Limit Switch 1. Upper limit for Climbing
— Digital 10 Limit Switch 2: Lower limit for Climbing
— Digital 10 Limit Switch 3: Inner limit for Battery Ballast
— Digital 10 Limit Switch 4: Outer limit for Battery Ballast
— Digital 10 Limit Switch 5: Frisbee Insertion stop sensor
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